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Settings and General Information 

1. Select Tools + Options… (Upper Frame) 
2. Switch to: Infrastructure + Part Infrastructure. 
 Under the External References enable: 
  Keep link with selected object 
3. Switch to: Parameter and Measure + Units 
  Set the units to Millimeters 
4. From the Start menu select: 
  Structure Functional System Design Select 

 the proper PRM file: 
  Tools  Project Management 

 

 Setting up the SFD/SDD environment 
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1.1  PRM-Project Resource Management: Project Activation 
 PRM: Project resource management allows administrators to manage the location of 

resources based on projects, disciplines, and applications.  The administrator will 
manage the XML based project file which will define the location of the resources (e.g. 
Catalogs, paths to resolved directories, management of the bounding box, management 
of Reference planes and Hull, definition of molded conventions etc..). 

 

Steps: 
For this exercise, we will perform the following:  
 Define a project file 
 Select the project interactively 
 Select the Discipline 
 View the resources of the project from tools options. 
 Modify the project file 
 Restart Catia and ensure that the modifications are reflected 
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1.1  PRM-Project Resource Management: Defining a Project File 

 

Environment Editor 
Environment variable 
CATDisciplinePath 
determines the location of 
the custom project files. 
Sample project file has been 
provided in …\…\….\…. 
Default project is CNEXT. 

CATDisciplinePath variable 
 

Use 
current  
CVI path 
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1.1  PRM-Project Resource Management: Activating a project interactively 

 Accessing the Project files interactively.  
 

The PRM files can be accessed 
interactively via Tools -> Project 
Management  

 
1. The Project Resource Management 

panel is displayed. 
2. Select your current project as the 

project and “Structure” as discipline 
and click OK.  

3. You can view the resources by 
selecting the browse button.  

4. You can use the “Validation” 
command to ensure that all the 
resources are defined correctly, and, 
to ensure that the defined resources 
exist.   

   
   

1 

2 

3 4 
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1.2  PRM - Resource Management 
Exercise: Project file Definition 

In this exercise, we will modify the location of the bounding 
box project xml file and edit the limits of the bounding box 

Place a functional deck to view the default limits of the 
bounding box. 

1. Structure Functional System Design -> Creates a 
new Product 

2. Structure Functional Object Design -> Creates a 
new Part in the functional system. 

 

Default Envelope 

Modified Envelope 

CATShipProjectEnvelope.xml 
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1.2  PRM - Resource Management 

Project file Definition (cont): 
1. Copy the CATShipProjectEnvelope.xml 

file to a folder on the C: drive from 
..\..\intel_a\startup\EquipmentAndSystems\
Structure 

2. Using wordpad, change the value for the 
bounding box in the x+ and x-directions. 
E.g.    x+ = 10000mm and x- = -5000mm. 

3. Save the xml file.  
4. Point to the project envelope xml in the 

PRM file by keying in the new location.   
5. Restart Catia and place functional deck.  

1 

2 

4 

3 5 

PRM XML File 
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1.3  PRM: Molded Conventions – ProjectParameters XML  File 

Molded Conventions: 
1. Set of rules governing the placement of the 

structural components. These rules are defined in 
MoldedConventions.xml file and are based on the 
ship axis defined by the ProjectParameters.xml  file.  

2. Some important parameters in the 
ProjectParameters.xml file :  
 Positioning Orientation – ‘Xp’ for European 

convention, ‘Xm’ for American convention.  
 Management of the Length unit. 
 Management of the Midship and Centerline 

frames. 
 

 
 

 

1 

2 

ProjectParameters.xml 

• Molded conventions are ignored for 
categories with implicit orientation. 
E.g.when placing brackets,you want 
to ignore molded conventions. 

• Category “Other” does not use 
molded conventions 

• Molded conventions ignored for 
beams 
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1.3  PRM: Molded Conventions – MoldedConventions XML File 

Molded Conventions: 
1. The MoldedConventions XML file determines the 

placement rules for the structural objects. For example: 

  For DECK Plates: ThicknessOrient – HP 
i.e. Horizontal Plus or HM Horizontal 
Minus. 

 For Longitudinal Bulkhead Vertical 
Stiffeners: Platesideorientation = LI or LO, 
SectionOrientation = TI or TO, 
AnchorPoint = WSL or WSR 

New R16 

MoldedConventions.xml 
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Addition of Functional Subclasses: 
  

1. Open the SFD Sample Feature 
Dictionary (ensure that the CATfct file 
has write privileges). 
CATStrFunctionalDesignSample.CATfct 

2. Select the “Create Subclass” icon. 

3. Add a new Functional Subclass (e.g. 
WeatherDeck) by activating the 
“Deck” node. Click OK. 

4. The new functional class is added.   

2.1  CATfct Integration: Creation/Management of Functional Classes 
 

1 

2 

3 

4 
Note: Classes referenced by 

the feat file cannot be 
deleted. Newly created subclass. 

Note: Same data model for SFD 
and SDD, single user 
dictionary.  
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 2.2  CATfct Integration: Creation/Management of Attributes 

  Addition of Attributes in the CATfct file and 
management of discrete attributes.  

  

1. Activate the Functional Subclass that was added in 
the previous page.  

2. Select the “Add Attribute” icon 

3. In the Add Attribute dialog box, key in the following:  

Attribute name: Style 

Type: String 

This attribute will have discrete Values.  

4. A discrete attribute is created. Save the Feature 
Dictionary. 

2 

4 

1 

3 

Note: Local attributes are propagated to the subclasses that belong to 
the superclass.  For the subclasses, these attributes will reflect as 
inherited attributes. 
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  Creating the discrete list of attribute values.  

  

1. In the startup 
\intel_a\startup\EquipmentAndSystems\DiscreteValues  
folder, create a file with the same name as the attribute name. 
(e.g. Style.txt). 

2. Add the discrete attributes to the text file.  

Save the discrete list file.  

 

 

 

 

 

  

2.2  CATfct Integration: Creation/Management of Attributes    ...continued 

2 

1 
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Note: ID schema is saved in 
the data dictionary 
folder. Child classes 
inherit the schema from 
parent if undefined. 

 Creating an ID Schema for the Functional 
Class 

  

1. Open the Structures Feature Dictionary 
document. CATStrFunctionalDesignSample.CATfct 

2. Double-click (activate) the functional class that 
you created in the previous pages. 

3. Select the “Define ID Schema” icon 

4. From the “Define ID Schema” dialog box, select 
the “Define/Modify ID schema” button.  

5. Modify the schema by adding a schema. (You 
can experiment with the other options that are 
available in this dialog box.  

6.  Click OK to complete the definition of the 
schema.  

7. Click OK to exit the Define ID Schema dialog 
box..  

2.3  CATfct Integration: ID Schema Integration 

1 

2 

3 

4 

5 

 ID is reflected when 
placing the components 
into the design 
document.  

6 
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 Some Important Points for Color management. 
  

1. Just as in ID Schema management, Color is managed via the PRM file.   

 

 

 

2. The default location referenced in the PRM file is: 
..\..\..\intel_a\startup\EquipmentAndSystems\StrFunctionalDesign\DataDictionary 

 

3. The color change is saved in the respective XML file. For example, when the color for the Deck is changed, 
the respective file    clr-DeckPanel.xml  will contain the reference to the new color.    

                                         

 

 

 

 

4. The data is saved into the xml file therefore, you need to ensure that you have write access to the files 
referenced by the PRM resource. 

5. Just as in ID Schema, if color is not defined on a particular subclass, it is inherited from the parent class. 

 

 

2.4  Color Management based on Object Classes 



Copyright DASSAULT SYSTEMES 2005 17 

2.4  Color Management based on Object Classes ...continued 

 Management of object colors based on 
subclasses.  

  

1. Open the SFD/SDD Feature Dictionary located 
in ..\..\..\intel_a\resources\graphic. 

2. Click on the “Define Color” Icon. 

3. Select the Subclass (e.g. Deck), select the 
appropriate color and click OK to exit the 
“Define Color” dialog box. 

4. Close the Feature Dictionary. 

5. Restart Catia 

6. The new color will be reflected when placing a 
component from the subclass that you used to 
define the color. 

7. If you have changed the color manually, you 
can use the “ResetColor” command by 
rightclicking on the object or in the spec tree 

 

2 

3 

1 
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 Open the CATPart 
(DIN_Halbierte_I_BigScale.CATPart) 
located in 
..\\intel_a\startup\components\Stru
cturalCatalogs\DIN\Models. (or a 
section that you would like to 
modify). 

 

 If you intend to customize this as 
a “new” section, use the “save 
as New” option. This may be 
necessary if you are creating a 
custom section for your project.  

 

 Before adding the single 
representations, you can modify 
the custom section and ensure 
that the user parameters are 
defined.  (Please refer to next 
slide for list of mandatory 
parameters) 

  

3.1 Managing Sections: Use existing section and add the simplified representation 

If a site needs to build a new section (parametric 
or resolved), it is the recommended best practice 
to start from an existing section and perform a 
“Save as New” on this custom section. By 
starting from an existing section, you are ensured 
that the mandatory parameters are already 
created and available for edition. 

New R16 
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3.2 Managing Sections: Description of Section Parameters 

Mandatory for structure application: 
SectionName: parameter coming from a key word of the section catalog 
A: Cross-sectional area 
ProfileType: Tee, Channel, RectangularBar, Beam, Angle, Pipe, RectangularHollow 
FamilyName: parameter coming from a key word of the section catalog 
CatalogName: parameter coming from a key word of the section catalog 
R2: Radius parameter 
SLOPE:  Angle parameter 

Mandatory for Analysis 
Sx: Section modulus along x axis 
Sy: Section modulus along y axis 
P: linear weight (kg/m assuming that the material used is steel: 7850kg/m3)  
L: Span length 
Vxm: Distance between COG and the farthest point on the section along –x  
Vxp: Distance between COG and the farthest point on the section along x  
Vym: Distance between COG and the farthest point on the section along -y  
Vyp: Distance between COG and the farthest point on the section along y  
Ix: Moment of inertia along x axis 
Vx: Inertia modulus along x axis 
Gx: Radius of gyration with respect to the x axis 
Iy: Moment of inertia along y axis 
Vy: Inertia modulus along y axis 
Gy: Radius of gyration with respect to the y axis 
J: Torsional constant of a cross-section 
Ax: Computed Surface with respect to the x axis 
Ay: Computed Surface with respect to the y axis 
Alpha: Ratio of hybrid girder web yield stress to flange yield stress. 

Legacy parameters: 
[PartNumber]: -Not used- Was mandatory for parametric design table in previous releases  
[Material]:  -Not used- Was created systematically in any CATPart in previous releases 
[Code]: -Not used- Was mandatory for parametric design table in previous releases 

Sections parameters description 
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 Adding a simplified representation to 
an existing section: 

1. Using the Part Design Workbench, 
doubleclick the sketch to invoke the 
sketcher. 

 Note: For parts that need the edge of the 
web to be welded to the plate, e.g.  ‘L’, 
‘T’, FL, ‘Bulb’ sections, you need to 
rename the points that define the left, 
center, and right of the web section.  This 
will allow the section to locate correctly 
when placed on the plates. 

3. Rename the left point in the sketcher as 
catStrWebSideLeft 

4. Rename the center point as 
catStrWebCenter 

5. Rename the rightmost point as 
catWebSideRight 

 

  

3.3 Managing Sections: Adding  the Web attributes for the molded conventions 

5 
3 

4 

Rename points 
for molded 
conventions 
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 Adding a simplified representation to an 
existing section: 

1. Using the Part Design Workbench, doubleclick the 
sketch to invoke the sketcher. 

2. Ensure that the “Construction/Standard Element” 
option is not set. 

3. Sketch the simplified representation.  

4. Select the two lines that you created for the 
simplified representation, 

  

3.4 Managing Sections: Adding  a simplified Representation 

2 

3 

1 

4 
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3.4 Managing Sections: Adding a simplified representation 

8 

9 

7 

6 

 Cont..   

5. In the “Tools” toolbar, select the “Profile 
Feature” button. 

6. Change the Name to 
“SimplifiedRepresentation” and ensure 
that the Input Geometry and Output 
Geometry areas display the sketch 
lines that you have selected.  

7. Change the Color (e.g. Yellow). 

8. Change the “Mode” field to “Wire 
(Explicit Definition). 

9. Ensure that the “Check Connexity” 
button is NOT set.  

10. Click OK to exit the profile definition 
dialog box. 

11. The simplified representation should 
display in the spec tree. 

12. Save the CATPart. 

5 

10 

11 
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3.5 Managing Sections: Resolving the section containing the simplified rep.  

2 

1. Use the input directory containing the parametric 
sections 

2. Create an output directory for the resolved sections.  

3. Execute the command CATCloGenerateResolvedParts.bat 
located in ...\intel_a\code\command  

4. Refer to the syntax and the required parameters 
below:  

 

Remember to use  
the –appl Structure  
option 

Resolved sections are 
created in the referenced 
directory 



Copyright DASSAULT SYSTEMES 2005 24 

  

3.6  Managing Sections: Adding the resolved sections to the catalog for SR1.  

1 1. Start a new catalog document 

2. Rename the chapter to “Din_Catalog 

3. Click the “Create/Modify catalog 
command 

4. Select the application  

5. Select the directory containing the 
resolved parts 

6. Click OK to generate the catalog. 

7. Save the Catalog 

 

2 

3 

5 

4 

6 

7 

SR1 Only, for SFD and 
SDD, use material mgt (skip to next slide). 
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3.6  Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

a) Manage the thickness CATpart(s).  

b) Create your Structural Specifications 
catalog 

• Add the thickness part to each 
plates family 

• Add the resolved sections to each 
profile family 

• Manage keyword value (Y/N) for 
each section. Ignored at family 
level 

c) PRM resource -> Standard and 
Specification Catalog 

SFD/SDD 
Only 

For R16, when placing structural 
components, there is a new  
concept – material mgt. 
Components are placed based on  
the structural standard, material, 
and grade.  

New R16 
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3.6 (a) Managing Sections: Manage the thickness CATpart(s).  

1. Open the sample Thickness CATPart provided to 
you. Location:  

 \intel_a\startup\components\StructuralCatalogs\Materials.  

 Filename: Thickness.CATPart (Ensure that you have write 
access to the part and the design table text file). 

2.  Click on the “Edit Table” button and add a new thickness at 
the end of the list, add the entry Thick 11 – 50mm (tab 
delimited). Save the text file.  

3. Save the thickness CATPart. 

1 

2 

New R16 
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3.6 (b) Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 1 

1. Start a new catalog document. Edit 
definition (right click) on the chapter and 
rename it (Specifications) 

2. Add a new Discrete keyword (String) to 
the Specification chapter (Keyword 
name “Spec Mode”).  Downstream, this 
keyword will act as a filter whether 
sections are to be flagged as spec or 
unspec.  At the family level, you will be 
able to set the keyword (Y/N). Enter the 
legal values (upper case) Y and N. 
Ckick OK. 

3. Set default to Y. 

 

2 

3 

New R16 
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3.6 (b) Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

3. Note: the standard is reflected in the 
PRM file.  

Default is AISC, we will change this standard 
to DIN in the PRM later 

 

 

 

4. Add the chapter for the Standard. Make 
sure to check the “Copy Keywords” 
option 

5. Save your Catalog. 

 

4 

3 

5 

New R16 
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3.6 (b) Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

6 
6. Add a chapter for the material (Steel) and add a 

chapter for the material grade (D40). – this is only an 
example, the actual DIN catalog will have specific 
grade names.  

7. Add two families under the grade chapter.  

• Profile- For the Resolved Sections 

• Plates – For the Thickness 

8. Add the thickness list in the Thickness CATpart to the 
plates family:  

• Activate the Plates family.  

• Select the “Add Part Family Components” icon. 

• Select the thickness CATpart.  

• Click OK 8 

7 

Note: Currently we only support 
“Plates” and “Profile” families. 

New R16 
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3.6 (b) Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

9. The thickness list is resolved and added to the 
“Plates” family.  You can change the keyword 
value of each of the thickness entries by double 
clicking it and by selecting individual descriptions. 

8 

9 
New R16 
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3.6 (b) Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

10. Adding the sections to the Profiles family: For adding the resolved sections to 
the Profile family, we will use the “Add Component” icon and select each 
resolved section. Add the following sections from the resolved catalog (for this 
exercise, we will add the first 14). 

10 

New R16 
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3.6 (b) Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

10. Using the same procedure as on page 30, 
set the keyword for the sections in rows 5 
thru 10 to N by double-clicking each entry 
and changing the keyword value to N. 10 

New R16 
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3.7 Managing Sections: Point to the catalog using the PRM resource for 
SFD/SDD 
 

11. Change the Standard in the 
PRM file: Open the PRM, switch 
the standard from AISC to DIN.  

12. Point to the Str. Specifications 
catalog you created in the 
previous steps. E.g.  

 

 

 

 

 

 

 

 

 

13. Save your PRM file. 

11 

12 

New R16 
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3.7 Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

Restart Catia.  

13. The PRM that you modified 
should point to the updated 
standard and catalog.  

13 

New R16 
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3.8 Managing Sections: Catalog management for the resolved sections for 
SFD/SDD: 

Restart Catia.  

14. Place a Deck: The material 
thicknesses are displayed.  

New R16 
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3.8 Managing Sections: Place the custom section into a design document. 
 

15. Place a Stiffener: The material 
thicknesses are displayed and the 
Sections that you have created as 
displayed.  

• Note the difference between the 
sections with the Spec Mode 
keyword flagged as ‘Y’ Green) vs. 
‘N’ (Caution icon). Preferred List Display 

New R16 
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3.9 Managing Sections: Management of the Preferred List via PRM 
 

• Management of the “Preferred List” in PRM.  The PRM resource: 
MaterialManagementMode is used to manage the preferred list.  

The possible entries for this resource are : “ActiveUnSpec”, “ActiveSpec” and “” (Blank). 
 

ActiveUnSpec: This means that the preferred list mode is not enabled by default. The 
entries shown in the panel are both preferred and non-preferred values. The user can click 
on the check box to temporarily override the option and then only preferred entries are 
shown. However when the user exits the command and re-enters, then the mode is 
unchecked. The mode is not stored in the CATSettings. 
 
ActiveSpec: This means that the preferred list mode is enabled by default. The entries 
shown in the panel are only preferred values. The user can click on the check box to 
temporarily override the option and then both  preferred and non-preferred entries are 
shown. However when the user exits the command and re-enters, then the mode is 
checked. The mode is not stored in the CATSettings. 
 
“” (Blank): This means that the user intends to read the mode from the CATSettings file. In 
this case, when the user overrides the mode and leaves the command and re-enters it, it 
remains set to the previous one. 

New R16 
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4. Reporter: Report Definition and Execution 

• Execution of customized reports based 
on the attributes defined in the Feature 
Dictionary.  

• Administrators can define  customized 
queries. 

• Calculation of weight based on material 
type and section length. 

• Save reports as excel files, html files, txt 
files.  
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4.1  Reporter: Defining a Query 

Steps : 
Report Definition (Query 
Definition):  
1. Using the “Edit->Search” 

command,  select the 
Workbench (StrFunctional 
Design) and Type (Functional 
Stiffeners).  

2. Click on the “Search” button. 
3. Click on the “Add to 

Favorites” button. 
4. Key in “Functional Stiffeners-

Query” and click OK, Close 
the “search” dialog box.  

5. Click OK to exit the Edit 
Search dialog box. 

2 

1 

3 

Sample query based on functional stiffeners 

5 4 
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4.1  Reporter: Report Definition (2) 

Steps: 
Report Definition :  
6. Select the Tools -> “Report Define” 

command. The “Report Definition” 
dialog box is displayed 

7. Key in the Report Title: Functional 
Stiffener Report 

8. Select the appropriate entries: 
1. Dictionary: StrFunctionalDesign 
2. Type: Functional Stiffener 
3. Attribute: Section Name 

9.  Click “Add” in the Attribute Row.  

 For this exercise, we will create a simple 
reporter for a List of functional stiffeners 
based upon the section type. .  The report will 
include the Length, Weight and quantity. 

   

6 

7 

8 

9 
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4.1  Reporter: Report Definition (3) 

Steps (cont): 
Report Definition :  

10.Click in the “GroupBy” field and select 
the “Quantity” button.  This allows you to 
report the quantity of each type of 
section.  

11.Add the Length and weight Attributes 
and click on the “sum” fields.  

12.Add the query that you defined using the 
Edit Search command.   

13.Save the Report file.   
 
 

 

11 

10 

12 

13 
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4.2  Report Generation (1 of 2) 

Steps: 
Report Generation: 

 
1. Select the “Report Generation” 

command from Tools command 
2. Select the reporter that you have 

created in the previous steps.  
3. Using the option “Objects from 

Predefined Query”, click OK. The 
report preview is displayed. 

2 

1 

3 
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4.2  Reporter: Report Generation (2 of 2) 

Steps (cont): 
Report Generation:  

4. You can also use the “Save As” option 
and save the report as a file of html, 
txt,csv, xml, xls format or insert the 
report into an existing 2D Document.  
We will save the report as an HTML 
file and open it using the browser. Use 
the “SaveAs” button to save the report 
as an htm file.  

5. Using the browser (e.g. Internet 
Explorer), open the output file.  
 

 

5 

4 
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5.1 Definition of Project Plane Systems - Overview  

The project plane systems that are common to the project will be defined in the ReferencePlanesSystem.xml 
file. By default this file contains Plane Systems with planes named LONG, DECK and CROSS. Planes defined  
in this xml would appear under Project data whenever a new functional system is created. 

Reference Planes XML 

The following changes can be made to the project 
planes: 

1. The offset values for the planes can be modified.  

2. New planes can be added e.g, DECK.10, 
DECK.11 etc.  

3. Name of the sub-system e.g DECK can be 
modified 

4. Names of the planes e.g, DECK.1, DECK.2,....etc 
can be modified. 

New R16 
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5.2 Plane system hierarchy within a system - Overview 

NOTE: Creation of plane systems is an administrator task 

Plane Systems defined in this XML file are seen inside the 
Project data under each Structure Functional System  and 
Structure Detail CATPart(s).  

1. Once the administrator defines the Project planes in the 
reference planes XML file, the end users can create a 
Structure Functional System from the Structure 
Functional System Design workbench.  

2. Notice all the planes defined in the reference planes 
XML are now seen inside the Project data.  

3. Make sure you point to the correct resource in the PRM 
file for the Plane Systems before creating a functional 
system.. 

New R16 

Project XML file 

NOTE: Minimum of three plane systems are required 

1 

2 

3 
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5.3 Plane System Definition -   Exercise New R16 

1. Open the ReferencePlanesSystem.xml file and perform 
the modifications shown below: 

Add these two new plane 
definitions. Plane names 
can be any e.g MyDeck1 
and MyDeck2.  

Original XML 

Modified XML 1 

Located in ... \intel_a\startup\EquipmentAndSystems\Structure 

NOTE: This task 
should be performed 
before beginning your 
project.  



Copyright DASSAULT SYSTEMES 2005 47 

5.3 Plane System Defined in XML:  Exercise    ...continued New R16 

2. After Modifying save and close the Reference Plane XML. 
 Now in Structure Functional Design workbench create a Functional System. 

Notice the new planes 
that were defined in 
the XML appear in the 
design document and 
in Specification tree. 
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5.4  Plane System Synchronization - Overview 

Plane system synchronization refers to updating the planes in the 3D whenever Reference plane XML 
undergoes changes. When these changes are made in the middle of the design process, the synchronize 
plane command will update the planes as well as all the structural objects that are affected by the new plane 
system definition. The Synchronize Plane Systems command supports the following changes.  

1. Plane Name change 

 Change of name of any plane in the XML. Make sure that you have the write access on the XML. 
Now save and close the XML. In the CATIA session right click on the project data inside the 
Function System Part and click on the Plane System synchronization option. Notice that the new 
name of the plane would be seen in the specification tree. 

 Limitation: The changes to the sub-system names e.g DECK, CROSS, LONG won’t be 
synchronized. Synchronization only works with the name changes of planes e.g Deck.1, Long.1 etc 

2. Plane Offset value change 

 Change the offset value of any plane or planes. As above repeat the plane synchronization step. 
Notice that the plane would move to respect the new offset value in the XML. Any structural object 
if defined on this plane would also move to follow the plane.   

 
3. Addition of new planes 

 
 Addition of new planes in the Reference Planes XML as discussed in section 5.3 can be 
 synchronized using the “Synchronize Planes System”. 

New R16 

These changes are shown pictorially in the next slide. 
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1. The names of the planes can be modified. Now on existing Functional Systems choose “Synchronize 
Planes” option so that the name changes are applied. New Functional Systems will automatically 
assume the new plane names. 

2 The shown offset value changes can be synchronized. Just make sure that the changes follow the 
ascending order. For example, you should not change 10000 for Deck.2 in this example to 4000. It 
should have an offset value between 5000 and 19000.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. To define a new plane, a complete row should be added as shown. Make sure that the offset value for 
this plane follow the ascending order. 

5.5  Changes supported for Plane Synchronization New R16 

The planes defined here are in ABSOLUTE not RELATIVE 

1 

3 

2 
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5.6  Plane System Synchronization:  Exercise New R16 

1. Create a Structure Functional System. In this system create a 
Transversal Bulkhead on a CROSS plane e.g, CROSS.64. 
Limit it using the Hull and a DECK plane e.g DECK.3. \ 

2. Place Transversal Bulkhead Vertical Stiffeners as shown on 
right side. For support use planes LONG.10, LONG.12, 
LONG.14, LONG.16. 

3. Open the ReferencePlanesSystem.xml file and enable write 
access. Do the following modifications to this xml as shown 
below: 
 
 

Modify the offset 
values 

Original XML 

Modified XML 

2 

With Original XML 1 

Steps:  

4.   After Modifying save the Reference Plane XML. 

3 
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5.6  Plane System Synchronization: Exercise ...continued New R16 

4.      Activate the Part level and Invoke Structure Functional  
         Object Design workbench.  
         Right-click on the Project Data and select “Synchronize  
         the Planes” command. 

5 

5.      The following error message will be generated. This is because the  
 planes that no more coincide with the Bulkhead due to a change in  
         their offset values can no longer be used as supports for placing  
         the stiffeners. Click OK. 

4 

6. Notice the planes move to their new offset locations. Stiffener TBhd_VStf_33 
         whose plane is out of bounds is seen in red. Delete this stiffener manually.  

6 
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5.7  Hull CATPart: New Resource in PRM 

The default Hull CATPart is also a new resource 
pointed to by the PRM. By  
default it is named Hull1234.CATPart. This 
resource is seen under each Structural System. 

1. Location of the default 
Hull1234.CATPart 

2. Open the Hull1234.CATPart. 
Notice the Hull1234 feature 
inside the Geometrical Set.1 

3. Upon creation of a Functional 
System this Hull feature is 
copied under the Project data.  

Before starting working make sure 
that the PRM file points to the correct 
Hull feature. Check the name and the 
location of the resources. 

1 

2 

3 

Hull CATPart 

Hull Feature 

New R16 



Copyright DASSAULT SYSTEMES 2005 53 

5.8  Hull Synchronization: Overview 

Administrator could make several changes to the Hull resource, e.g: 
 
Case1:   Use a new HullCVI.CATPart and point to it in the PRM. 
Case2:   Same Hull1234.CATPart and same feature Hull1234 names with a different geometry.  
Case3:   Same Hull1234.CATPart but different feature name and geometry. 

Note: Make sure this new Hull is present at the location to which PRM points. Also 
change the Midship and centerline location values in the ProjectParameters.xml to 
match the new Hull. 

Hull Synchronization refers to updating the design document once the Hull definition  
changes during the design process. Hull definition change could be any of the following. 

Case 1: 

New R16 

Before: Hull1234.CATPart 

Before: Hull1234 
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5.9  Hull Synchronization: Exercise continued... New R16 

Exercise Case 1: 

2 

3 

1 

1. Check the PRM to point to resources Hull1234.CATPart and to feature Hull1234  
2. Create a Structural Functional System. The default Hull1234 feature will be copied under the Project Data. 
3. Create two Transversal Bulkheads on any two different cross planes e.g, CROSS.30 
         and CROSS.60. Limit it by Hull1234 feature and DECK.2 planes.  



Copyright DASSAULT SYSTEMES 2005 55 

5.9  Hull Synchronization: Exercise continued... 

4. Point to a new Hull and Hull Feature in the PRM e.g, change Hull1234.CATPart to HullCVI.CATPart and from  
     Hull1234 to Hull001 feature in the project XML file.  
5. Save changes to PRM. Do “Save Management” on the design document and close CATIA session. 
 Restart CATIA session and open the saved document.  

Exercise Case 1: ...continued 

Note: Make sure that the new Hull that you point to in the 
PRM is also present in the location specified.  

PRM: 

4 

New R16 

New “HullCVI” 
CATPart 

5 



Copyright DASSAULT SYSTEMES 2005 56 

5.9  Hull Synchronization: Exercise continued... New R16 

Exercise Case 1:...continued 

6. Activate the Part level and right-click on SfdProjectData. Select the “Synchronize the 
Hull” command.   

7. Right-click on Structure Functional System CATPart and select “Local Update”.   
8. Notice the Bulkheads update for the new Hull 

6 

7 
8 Bulkheads 

updated 
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6.1  Define EndCut using UDF technology New R16 

Simple description of “User Define Feature” concept: 
  

Start Point End Point 

Line.1 

Volume Extrude.1 

Circle.1 

To define a new EndCut, the administrator has to create a UDF and add it in the catalog of detailing features. 
The end user will then be able to place it in its design using a dedicated contextual menu in the stiffener command. 

Defining a UDF is a way to group a set of features so that they are seen as only one feature. This new feature can 
then be reused in new contexts. 
 
Example:  I want to create a new type of object:  the cylinder between two points. 

EndCuts are UDF with the following characteristics: 
1- The result of the UDF must be a volume. (This volume will be removed from the profile to display the proper result) 
2- The inputs of the UDF (characteristic edges/faces of a profile) have to follow a particular naming convention 
 to be automatically retrieved when placing the endcut.  
 

UDF content 

UDF inputs 

Inputs of a UDF 
are deduced from its content  
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New R16 

2. File  Save 

We will start from a sample CATPart which contains a profile 

We want to create this Endcut on a stiffener: 

6.1  Define EndCut using UDF technology      ...continued 

1.      File  New from   intel_a\ ...\Tee\T-EndCutTemplate.CATPart    +  Rename document  

3. Right-click on UDF definition feature from the tree and select  
 “Define In Work Object”. We will now define the geometry  
 required for the UDF Definition. 

NOTE: In the next slide we will define UDF features:  
Point, Plane, Circle, Extruded Volume 
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New R16 

1 

5 

4 

2 

Point Definition:  Under the currently activated “UDF Definition” GeometricalSet,  
             create a point at the middle of MoldedFlange1 start edge by following the steps below: 

3 

6.1  Define EndCut using UDF technology      ...continued 

1. Click on the GSD point command 
2. For “Point type” field  select “On Curve”. 
3. For the “Curve” field select  
 Shape_Edge_MoldedFlange1_Start from “Input”  
 Geometrical set. 
4. Select “Middle Point” option 
5. Click OK 

Result 
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New R16 

Plane Definition:   Under the currently activated “UDF Definition” GeometricalSet, create a Plane normal 
              to MoldedFlange1 start edge passing through the previously created point. 

1 

2 

3 
4 

1. Select the GSD “Plane” command. 
2. For the “Plane Type” field choose “Normal to Curve” 
3. For the “Curve” field choose the “Shape_Edge_MoldedFlange1_Start” from the GeometricalSet named “Input”. 
4. For the “Point” field choose previously created point. 
5. Click OK 

6.1  Define EndCut using UDF technology      ...continued 

Result 

5 
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New R16 

Circle Definition:  Under the currently activated “UDF Definition” GeometricalSet, 
   create a Circle centered on the previously created point. 

1 

2 
3 

4 
5 

6 

1. Select the GSD “Circle” command. 
2. For the “Circle Type” field choose “Center and axis”. 
3. For the field “Axis/Line” field pick “Shape_Edge_MoldedFlange1_Start” 

from the GeometricalSet named “Input”. 
4. For the “Point” field choose previously created point. 
5. Specify a Radius of 100mm. 
6. Click OK. 

6.1  Define EndCut using UDF technology      ...continued 

Result 
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New R16 

1 

5 

4 

3 

2 

So far UDF definition GeometricalSet in the spec tree 
looks like this:  

Volume Definition:  Create a Volume Extrude from the circle using the plane as direction. 

6.1  Define EndCut using UDF technology      ...continued 
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New R16 

UDF Definition: 

1 In GSD Replication toolbar select Userfeature Creation command.  
2 While the Userfeature Definition dialog box is open select the UDF Definition GeometricalSet from  
 the tree.  
3. Give any custom name to your UDF. 

1 

3 

2 Inputs of 
our 
EndCut 

Now our construction geometry is ready, we can create the UDF. 

6.1  Define EndCut using UDF technology      ...continued 
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New R16 

Main result of the UDF 
should be a Volume. 

Active Tab 

Active Tab 
4. Activate the Parameters Tab 
5. Administrator can Publish any  
         parameter so that the EndUser  
         can modify it at the Instantiation  
         time. Publish Radius parameters 
 and rename it.  
6. Activate the Output Tab. Notice Output  
 is a volume 
7. Click OK. 
8. Right-click on the UDF from specification 
 tree and select Local Update.  

4 

5 

6 

7 

8 

6.1  Define EndCut using UDF technology      ...continued 

UDF Definition:  ...continued 
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6.1  Define EndCut using UDF technology      ...continued New R16 

UDF Definition:  ...continued 

9. Now we will add Boolean remove feature to the Part body so that we do not see the Cylinder volume 
 in the preview.  
 Insert  Boolean Operations  Remove  
         For “Remove” field select Volume Extrude and for “From” field select PartBody. Click OK. 
10. Do Local Update on PartBody 
11. Hide the UDF Definition from the specification tree. 

11 

9 

10 
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6.2  Add EndCut to the detailing features catalog 

1. Open the DetailingFeatures catalog. This is a catalog of UDFs for EndCuts and Slots.  
2. Activate the chapter “Tee” and click on the “Add Component” command. 
3. Click on the “Select external feature” command and from the design document select the UDF from the  
 tree under the Knowledge template.  
4. Click OK. 
5. Notice the UDF is added to the catalog. 
6. Save the catalog. 

4 

3 
2 

5 

1 

DetailingFeatures catalog 

New R16 
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EndUser Task: Instantiation of the EndCut 
New R16 

1. Open Structure Detail System Design workbench 
2. Check project resources to make sure it points to the correct detailing features catalog. 
3. Create a Design Unit. 
4. Invoke Structure Detail Object Design Workbench and create one Deck and two transversal Bulkheads  
 using the Plate command. 

1 

2 

3 
4 
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5. Place stiffeners on the Deck using 
“Stiffener” command and limit it by 
the Transversal Bulkheads as 
shown. 

 For this exercise pick the section 
WT8X25 from Material & Orientation 
tab. 
 

6. Define an end cut at one of the  
 extremities of the stiffener. From the  
 catalog feature browser window pick  
 EndCut_UDF_CVI that we added 
 to the catalog. Click OK. 
 
7. click OK on “Choose Feature” 
 dialog box. 
 
8. Zoom in to see the Endcut on the 

stiffener. 
 

EndUser Task: Instantiation of the EndCut 
New R16 

5 

6 

7 

8 
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END 
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